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Getting started

This chapter explains how to install the Meridian Configuration Program, and gives a general
overview of its key features.

Getting started

Overview

The Meridian Configuration Program is a Windows application that
lets you design the configuration of your G Series or 800 Series
products to suit both your own personal preferences and the
particular configuration of other equipment in your system.

It uses an intuitive graphical interface that prompts you at every
stage for the information it needs to complete the system. When
you have designed the system to your requirements you can save
the configuration to the appropriate Meridian products in the
system via a serial link connected to the back of each product.

How it works

The Meridian Configuration Program reflects Meridian's system
approach to designing audio products and presents a graphical
representation of your whole system. It allows you to create a
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single configuration file representing the settings of each product in
your system and the way they are interconnected. This file is stored
in the controller of the system for future reference. As well as being
far more convenient than configuring each product independently,
this approach also enables the Meridian Configuration Program to
check that the settings you are proposing are appropriate for the
particular combination of products in the system.

The Meridian Configuration Program is structured as a wizard;

it leads you through a series of stages from the Welcome

page through to the Finish page, which is reached when the
configuration has been completed. A Breadcrumb Trail below the
toolbar at the top of the Meridian Configuration Program
window shows your current position in the sequence of pages and
allows you to jump back to an earlier page to check a particular
setting you made.
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Getting started
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Benefits of using the Meridian
Configuration Program

Configuring your system with the Meridian Configuration Program
offers several important benefits. In particular:

e You can configure the entire system in a single operation.

e |t is more convenient and more intuitive than using the front-
panel menus.

 You have access to many advanced configuration options that are
not available from the front-panel menu.

 You can conveniently edit the names of sources, DSP presets, and
radio presets using the keyboard.

® You can edit the G Series soft keys.

o If your controller is a G68 or 861 you can take advantage of
Meridian Room Correction.

e You can set up multiple systems far more conveniently than by
manually configuring each product.

e You can keep a record of the configuration of your entire system
in a single document on your PC.

If you have made manual adjustments to the configuration of
a product from the front panel, you can fetch the product’s
configuration into the Meridian Configuration Program as the
starting point for the configuration of your system, in order to
retain the settings, such as calibration settings.

Meridian Control Window

The Meridian Configuration Program is supplied with the Meridian
Control Window utility, a separate PC application that allows you
to control any Meridian product via a serial cable (or USB cable
on certain products) using a simple push button interface that
emulates a Meridian MSR+ or MSR remote control. Alternatively it
allows you to submit commands by name, and supply parameters
for commands that take a value, such as the volume setting.
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The Products page

The following illustration shows the key features of the Products

page, which lets you specify how your system is interconnected:

{44} Meridian Configuration Program - Untitled [Products™]

File Yiew lnseit Help

=B ]

DEFE|E = =s 3|5 )

Breadcrumb Trail

tart > Products > Newt

@ Thiz pags allows you to insert Ppioducts into the system by dragaing fram the Presource bar and diopping in the right-hand pane. You can Blinser a source

or Birsert 5 speaker

Toolbar

Tabs to add new products

Resource Bar
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Getting started

Installing the Meridian Configuration Program
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Requirements

To use the Meridian Configuration Program you need:

e A computer running Windows 95, 98, 2000, NT 4, ME, or XP.
e 10Mbytes of free disk space.

The Meridian Configuration Program communicates with the
products you are setting up via a serial cable. The computer you are
using needs to have a nine-pin serial port available, or you can use
a USB/serial adaptor.

Alternatively some G Series products include a USB port, in which
case the Meridian Configuration Program can communicate with

them via a USB cable connected to the computer’s USB port.

The software requires a mouse or similar pointing device — it
cannot be operated solely from the keyboard.

To install the Meridian Configuration Program
e Insert the Meridian Configuration Program Installation CD-ROM.

The Setup program should run automatically when the CD-ROM is
inserted. If not, locate setup.exe on the CD-ROM and run it.

The Setup program Welcome page will be displayed.

o Follow the wizard.

On the Preferences page:

e Leave Install for all users selected, unless you want to restrict
use of the program to yourself on a multi-user machine.
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Quick tour

This section gives complete step-by-step instructions for creating a complete configuration for
a typical simple system. Even if this does not correspond to your own system we recommend
you follow the tutorial to give you a quick tour of the Meridian Configuration Program.

At each stage the Quick tour shows information in grey tinted boxes about the more advanced
features of the program, and the additional options for configuring 800 Series products.

Quick tour

Running the Configuration
Program

e Click Start, point at All Programs, Meridian, then click
Configuration Program:

/ Internet _J My Documents
Internet Explorer
—— | L9 MyRecent Documents +
Cmd %
H _“J My Pictures
E Microsoft Word _:, My Music
W .. o 1 My Computer
‘H Paint 59 stomn
I Accessaries ¥ lork Places
® Windows Media 77 admiristrative Tools  »

= % Configualion Pro
L";J Calculator ) Startup 3 1 Coniic
Microsoft Access "B Control Window
Micrasoft Excel WinFUP
icrosaft FrontPage

gram Help

gram

(crosoft Outlook
upport

Microsoft PowerPaint

Microsoft Word

WY MSM Explorer

<% MSN Messenger 6.0

Log OFf E)] Turn OFf Camputer

The Welcome page will be displayed. This provides links to useful
information.
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Using the Meridian Configuration
Program

The simplest way to use the Meridian Configuration Program is to
click the links in the Breadcrumb Trail and Information Bar at the
top of the window; for example:

Start > Products > Nest
This page alloves pou to insert Pproducts into the spstern by dragging from the resource bar and drapping in the fight-hand
window. You can Plinsert 5 source o @insert a speaker. If you wish to use passive speakers, you must first Einsert an
amplifer.

The Breadcrumb Trail shows a sequence of hyperlinks to pages you
have already visited; this is indicated by the blue underline. Clicking
one of the links takes you to the corresponding page to allow you
to check your settings on that page, or make changes. The last
entry on the Breadcrumb Trail is usually Next, which takes you to
the next page.

The Information Bar provides help about the current page, and
tells you what to do next. The Information Bar contains two types
of hyperlink: definitions, prefixed by a question mark icon, which
display a pop-up window with a definition of the item, and jumps,
prefixed by an arrow icon, which perform an action or jump to
another page.
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Starting a configuration

To start creating a configuration from the Welcome page:

e (Click the Next link in the Breadcrumb Trail:

Start » Mgt
page s the first one. Click the Next page (=] button in the toolbar to advance to the nest page in order to begin
the configuralion process

The Products page will then be displayed. This allows you to

define the products in your system and indicate how they are
connected together.

Getting help

For more detailed information about the Meridian Configuration
@ Program see the on-line help. To display the help: @

 On the Help menuy, click Configuration Program Help.

‘ ‘ Configuration Guide.indb 6 @ 12/11/04 3:34:40 pm ‘ ‘



Products: Adding a controller

The controller is defined as the product that selects sources and
controls the volume for the system; it is the digital surround
controller, preamplifier, or combination product. In this example it is
a G68 Digital Surround Controller.

o Click the insert a controller link in the Information Bar.

An Insert dialogue box is displayed to allow you to specify the
type of controller.

o Select G6BADV from the drop-down list and click the OK button
to add the product:

Insert Contraller 2| x|
| cancel

Controller type: [ GERADY

“ou can also insett controllers by dragaing or
double-clicking the contraller pou wish to
inset from the resource bar

You will then be asked whether you want to fetch an existing
configuration from the controller. If you are starting from scratch, as
in this Quick tour, you do not need to do this. For more information
see the Advanced tips on the next page.

o Click the No button to indicate that you do not want to fetch
data from the digital surround controller:

Fetch from Product 2] %]

If you have already set up the GESADY from the front panel
‘you may wish to fetch its settings
Do you wish to fetch from the GEBADY now?

I™ Remember my decision [don't ask me again)
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The Products page will then show a block representing the

G68ADV Digital Surround Controller:

(1) Meridian Configuration Program - Untitled [Products™]

=lo/x]
Eie View lnsst Hep
DS ES =2 3@ M e [RE)
Star > Products > Newt
Th = “You can Piser a source
g e GEBADY !
3 Bosea (Radio) [
& D5P420 I i
|z B ospsonn [
& ERDSPS000C [
£ B osesm !
= ERDSPSS0HC !
3 B pspeon !
2 B ospam :
= B pspeon |
& [ Anslogue [active]
3 |
2 [ trcoge passivel |
M33 H
|
MED | i
|
|
|
|
|
|
|
|
i
|
| &
|

B You must add front speakers
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Quick tour

‘ ‘ Configuration Guide.indb 8

Advanced tips

Adding products by dragging them from the Resource Bar
The most flexible way of adding products is to drag an appropriate
icon from the Resource Bar (to the left of the Products page)
onto the Products page:

o Tupe
= B
= Hcom G51 (Radio]
° Blco: T C
Blcs1 W
Bl Geseny 45
Bl Geacsoy Ad
[ [ "
Bl ceso 47
B GaioH
[ [ea]
|1 [
s

Fetching settings from a product

If you have changed any settings on a product from the front
panel since making a previous configuration, you can retain the
settings by using the Meridian Configuration Program to fetch the
configuration from the product, rather than starting from a default
configuration as described above. This is also useful if you cannot
locate the file on the computer.

e Connect a serial cable between the product and your PC, as
described in 7o connect the serial cable, page 23.

e When the Fetch from Product dialogue box is displayed click
the Yes button.

Performing other actions
Right-clicking on most objects on the Products page displays a
context menu of actions appropriate to that object:

GEBADY
B2 4 Fotch.

2, Stors

Propetties
e

Fename:

For example, to delete a product:
e Right-click the product, then click Delete on the context menu.

Note: If you delete the controller you will need to restart the
configuration from scratch.

Displaying or changing product properties
Many products provide a range of properties that you can change
for specific situations. To display the product properties:

e Right-click the product, then click Properties on the context
menu, or double-click the product.

The Properties dialogue box shows a list of the properties
associated with the product, and allows you to view or change
their values:

GBBADY Properties

Identification | Setup | Cannections | Sowces | Types |

21

This page displays the properties associated with each a physical source. The legend

@ chasen will apply to all Msridian products with soft keys
Legend: [Fadia MSR+ key: [2 [Radio] = Type: [GEBADY
—Additional information

@ More infomation is available only when you have not yet fetched ar Befiesh...

stored. Click the Refresh button to read the information fram the
product now.

Cancel

For detailed information about each of the properties refer to the
Configuration chapterin the Installation Guide for the product,
or the FAQs section in the on-line help. To display this click
Configuration Program Help on the Help menu.
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Changing the value of a property
o Click the value of the property.

e Choose an option from the drop-down list:

BB Moromods [aus LettsRight 7]
& opmr
If it is a numeric property you will get a spin button rather than a
drop-down list:

¢ Lowne

If it is an on/off property you can click the checkbox to change the
value:

| Fan O as necessay

Iy

If you have changed the value of a property an asterisk (*) is
shown after its name.

Reverting a property to its default value
o Right-click the property, then click Revert to Default on the
context menu:

% Centre depth”

The menu option shows the default value.
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Configuring 800 Series products

Adding an 800 Series controller

If you are adding an 800 Series controller a dialogue box will allow
you to specify one of the product’s standard card configurations.
Alternatively select Minimal to add a minimum set of cards at this
stage, in which case you will be prompted to add further cards as
you make connections to the product:

Insert 861 21x|
@ “ou can populate the BR1 you havs inserted ta match it to

one of the configurations below. s
" Analogue Theatre

IE42, 1400, CD20, EF20, TROO, V500 and two QAD3
cards will be added.

@ Digital Theatre

IE42, 1400, CD20, EF20, 0E12, 5L00, TROO and SO0
cards will be added.

" Minimal

Only those cards essential for the operation of the
surround controller will be added at this stane

I™ D net display this dialog again

Adding cards

You will be automatically prompted to add cards as required
when you add sources or speakers to the 800 Series product.
Alternatively you can add cards explicitly if you prefer:

Either:
e Drag the appropriate card icon from the 861 Cards or 800
Cards tab in the Resource Bar (to the left of the Products

page).

Or:
e Right-click the product icon, then click Add Card... on the
context menu:

& Eetch...

2 Store...

Propetties
¥ Delete
FEATE

.
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The following dialogue box allows you to specify the card type and,
when appropriate, the position of the jumper identifying the card:

Cancel

Card type: [ 0402 [36kHz unbalanced analogue output card] =

dumper [#1 [Fronts, Certres] =

Removing a card
e Right-click one of the outputs on the card, then click Remove
Card on the context menu.

Displaying the properties of a card
e Right-click one of the outputs on the card, then click the
Properties item on the context menu.

A Properties dialogue box shows information about the type of
card, its slot positions, and the jumper setting:

OA034#1 Properties

General | Connestions |

2

T 0A03 (192kHz unbalanced analogue
autput card)

Slotfs): 1213

Jumper setting: [#4 [Fronts, Sides] -

Displaying information about the cards
e In the Properties dialogue box click the Cards tab.

Initially this shows a graphic of the card positions:

861 Properties |

Setup Caids | Connections | Logical Cormestions | Identfication | Types |

The aaphic shows the recommended pasiions for the cards you
have defined. Right-click within the graphic to add or remave cards,
of to switch to 3 list view.

Cancel

To show a list of the cards:

e Right-click, then click Details on the context menu:

[v Graphic ! ’

Add Card...
Froperties...
Remove OAD3 Card

This shows a list of the installed cards:

861 Properties

Setwp Cards | Connestions | Identiication | Types |

X

Card [Jumper [ $lats [ Deseiption |
9 EC 1 2728 Power supply

20000 2526 Compuler card

=3 |E42 1417 tultichannel digital input card

20020 15 DSP cad

91400 35 Unbalanced analague input card
SBEF20 14 DSP card

H8 0403 1213 192kHz unbalanced analague output card
20403 1011 192kHz unbalanced analogue outpul card
EVS00 ) Videa switch card [composite and 5-Yidea]
3 TR0 12 Tape cad

ST R

Cancel

You can also add a card, remove a card, or display a card’s
properties in the Graphic or Details view by right-clicking, then
clicking Properties on the context menu.
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Products: Inserting a source

The next step is to add the sources in your system. For this Quick
tour we will assume a satellite receiver is required.

o Click the insert a source link in the Information Bar.

Start > Products > Next

This page allows you to insert Pprocucts into the system by dragging from the resowce bar and drapping in the right-hand
window. You can Finsert & spurce o Binsert a speaker. If you wish to use passive speakers, you must first Binsert an
amplifier i

An Insert Source dialogue box is displayed to allow you to select
the type of source.

e Choose Satellite from the drop-down list, and click the OK
button to add the source:

\ Cancel

Source type:

“ou can also insett sources by dragging o1
double-clicking the source you wish to insert

fram the resource har.

S atallite

The Connection Wizard is then displayed to assist you in
connecting the source to your other equipment:

Connection Wizard

This wizard will help pou connect products to your controller. You
can Use the Meridian default connections [as labelled on the:
back panel] o specify your own connections.

Do you wish to use Meridian defaults to connect to the GEBADY?

' Yes [recommended] Details.

To removs existing connections, apply the Meridian defaults,
and exit the wizard, click Finish.

" No (advanced)

Let me specify my own connections.
To continue, click Mext

[~ Inflwe do ot the wizard when p—
irserting products : Ly

o |eave Yes selected to make the recommended connections
between the source and the controller.
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The Meridian Configuration Program will use a set of connections
which match the back panel screening of the controller to make
wiring up straightforward

o (lick the Finish button to make the recommended connections.

The connections will be displayed on the Products page:

Sat[9] GEBADY(Radiol 2]

This shows the audio connection between the satellite receiver
optical output and the optical input O1 on the digital surround
controller, and the S-video and component video connections
between the satellite receiver and the digital surround controller.

You can now proceed to add the other sources in your system in a
similar way. In this example we are only inserting a single source.

See the Advanced tips on the next page for information about
modifying these connections; eg to use analogue rather than
optical for audio.
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Advanced tips

Showing a list of the recommended connections
e Click the Details... button in the Connection Wizard dialogue
box.

This shows the connections that will be made if you choose the
Yes (recommended) option:

Meridian Defaults: =]

Optical output O will be connected to GERADY 01
5 Video output 5 will be connected to GEBADY 53
Campanent Video autput ' will be comnected to GEBADY ¥3

Specifying connections manually
e Choose the No (advanced) option in the Connection Wizard
dialogue box.

o Click the Next button to continue.

o Specify each connection that you want to make from the source
to the controller, using the From: and To: drop down lists, then
click the Connect button to make the connection:

Connection Wizard _ HE

Please select the autput from the S atelite that you would like to
connect to the GESADY.

From: [4 [bnalogue] v Hew..
Io [#1 [bnaloguel -

™| Form & multishanne! connection; Connect

Click Connect to farm each connection; when you have
completed adding connections, click Finish to exit the wizard

I future do nat run th wizard when <Back

! Cancel |
inserting products

o Click the Finish button to close the Connection Wizard
dialogue box.

Renaming a source
You can give each source a name of up to five characters to
identify it on the front-panel display:

o Right-click the source, then click Rename... on the context
menu:

Satelie
B Comnection »

Correct

Properties
¥ Delets

The following dialogue box allows you to enter a new name:

x|
Legend: [Skl Cancel

The legend wil appear on the front panel of

products to which the saurcs is connected
@ The name you choose may not exeeed §

characters in lsngth, and must santain only

alphanumeric, space, hyphen (-] and period
characters [%

Changing the MSR+ key for a source
You can choose which MSR+ key selects each source:

o Right-click the source, then click Properties on the context
menu.

o Click the Identification tab in the Properties dialogue box.
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e Choose the MSR+ key from the MSR+ key drop-down list:

Satellite Properties x|

Identiication | Connestions |

This page displays the proptties assoiated with & physical sourcs. The legend chasen
applies to all Meridian products with soft keys.

Legend: [Sat MSR+key: [5[5a)  7] Tupe: [Satelite

10VCR1]
1 [VCR2]
12 [Game]

Cancel

Showing and hiding connections

You can choose whether or not source connections are displayed
by clicking the View or Hide Source Connections button in the
toolbar:

2l

Displaying information about the style of each
connection line
® On the View menu, click Legend.

Connecting using drag and drop
You can also connect between any two compatible connectors
using drag and drop:
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e Drag between the output on the source and the input on the
controller that you want to connect:

07 (CD) |I351 (R adio)

When you release the mouse button the cable will be connected:

GO7 [CD) G51 [Radio)
i

AS
o1 AF
Al AT
=1 A5
A9
Al0
Al

If the connectors are incompatible a stop cursor will be displayed:

07 (CD)

O1g—

Removing a connection
e Drag from one of the connectors and release the mouse button:

GO7 [CD) G51 [Radia)
[=}} AS
i
1

X s
AlD
Al

The cable connecting the two products will be removed.
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Making a multichannel connection

If you are connecting a product with multichannel outputs, such
as a G98DH DVD Player, to a digital surround controller with
multichannel inputs, the Meridian Configuration Program can
create a multichannel configuration when you drag between two
appropriate connectors:

EEERGIREY Y

> L sz |m oz
a
i
us sz
4
a7
5 22
ﬁ wvae
0
] "
0 oz
o7
0
08 sz
010
o1
D1z sz
03
04

A prompt allows you to choose whether to make a single or
multichannel connection.

If you choose Yes the multichannel connection will automatically

be made:
GIEDH[DYVD ) &
S ) e
v : h
o & "
Dg;x.n].
o
D,]M
B
&
&
&

Adding or removing inputs or outputs

With non-Meridian sources you can add new inputs or outputs,

or remove inputs or outputs, to reflect the connectors provided by
your source. For example, if your satellite receiver includes a digital
coax output you can add a connector for this:

o Right-click one of the source’s existing connectors, point to
Connection on the context menu, then click New... on the
submenu:

Satelite
[Sat]
=

o Propetties
Connect... Femoxe
Rename.
Fioperties
K Delete

Edf:

Fename.. .
Disconnect

The Add Connector dialogue box allows you to define the new
connector.

o Specify the type of connector using the Class and Type drop-
down list, enter a name, and choose Output or Input as
appropriate:

Add Connector 2l
‘You can add a input or output
o the product to reflect it L
physical characteristics. el
Class: [Audie =

Tvpe: | Digital Coax =
Mare: D1

@ Oupat O Input

o (lick the OK button to add the connector.
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Products: Adding speakers

The next step is to add the speakers in your system.
o Click the insert a speaker link in the Information Bar.

The Insert Speaker dialogue box allows you to select which type
of speaker you want to add, and the positions in which to add it.

o Select DSP8000 from the Type drop-down list.

The Location will automatically be set to Front left/right:

Type: [DSPEO0D - Cancel

L

’76‘ Front leftight E ‘

o Click the OK button to add the speakers.

The speakers will be added to the appropriate points in the layout,
and the connections will automatically be made between the
speakers and the controller:

/1) Meridian Configuration Program - Untitled [Products®] I =] 7]
File View Insert Help

[D&® (& e =[5 S m|e [ e @]

Start> Produots > Newt

o and droppingin the. 2

Th I o inta the system by
o Pinsert a speaker,

DSF33

DSP420
DSPS00
ESDSPE000C
DSP5500

8 DSPES00HE.
DSPEI00
DSPT000
DSPE000
Analogue [active]
Analogue [passive]
M3z

MED

[ Submoter

& D1500

& D2500

& M1500

@ 12500

GBBADY [Radio)

[ Other [ Scnmer | Arplifrs | Spssbear
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e Click the insert a speaker link again and select DSP5500HC
from the Type drop-down list to add a centre speaker:

=] R ] Cancel

Type: |DSPSEOOHC

Location

[ Eenlreljl  Rear \Eflﬂ‘nght|;|

The program will offer to add a 511 patch box to the layout to
connect the Comms cables for the speakers:

Insert 511 for Digital Speaker 1|

4511 slave patoh box is requited in arder to connect the digital speakers
Do you wish to insert one now?

I~ Remember my decision (don't ask me again)

o (lick the Yes button to confirm.

o Click the insert a speaker link again and click Analogue

(passive) on the Type drop-down list to add small analogue
rear speakers:

Type, [Analogue [passive]
Location
[(-‘ Bear left/right I;‘

e Click the OK button to add the speakers.

The Meridian Configuration Program will automatically prompt you
to add an amplifier to the layout to drive the passive speakers:

Insert Amp for Passive Speaker e |

@ Do you wish to insert an amplifier to diive the passive speaker?

I™ Remember my decision [dont ask me again]
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o (lick the Yes button.

e Click G57 on the Amplifier type drop-down list, and click the
OK button to add the amplifier:

Insert Amplifier 2|
m Concel
Amplfer type [557 -
[V Awtomatically connest to the controller
Yo can also nsert ampifiers by craging or
double-clicking the ane you wish to nseit
fiom the tesouce bar

The G57 will automatically be connected up to the appropriate
analogue output on the digital surround controller:

) Meridian Configuration Program - Unitied [Products~] -[of%|

Fle View Inset Help

DEE|%| e85 e @0 e

Stait> Products > Neat

youts inser [

pane. You can Pinsert 3 souce

ame:
DSP33
DSP420
DSPE00

DSPSSOCHL]

i DsPaa0g]
o

GEAADY (Radio]

DSPSSIOHE
DSPE00D
D3P700D
D5PE00D
Analogue [active]
Anslogue [passive] I E—
M33

M0
Subwaaler
B D150 e : :
B 02500 TR A
B M1500
8 M2500

[Othar [Souees | gl | Speskers
=g
3

Finally insert a subwoofer into the layout:
e Click the insert a speaker link in the Information Bar and select
Subwoofer from the Type drop-down list:

Insert Speaker 2] %]

| cancel

Type: [Subwoofer

~Location
@ Munm‘tenuefLFEIj © Stereo \eﬂfnghtE‘
© wide
The subwoofer has a crossover.
& Nairow
The subwaafer has no crossover, or it should be bypassed.

You can proceed to add any other speakers in your layout in a
similar way.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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The Speaker connections and Controller connections pages
will appear in the Breadcrumb Trail after the Soft keys page:

Advanced tips

Adding a speaker by dragging it from the Resource Bar
e Drag an icon from the Speakers tab of the Resource Bar (to the

(v Meridian Configuration Program - Untitled [Speaker connections®] _(oj %]

Fle View Insett Help

left of the Products page): s e et v SN B

@ ks]aﬁ:};ﬁlﬂcﬂam\:::ﬂliﬂolgzlin arsphical form by returning to the FProducts Page and cicking the Speker or Comms Connections

y Home [pSPEsa0H] = Fiom [To [IE=TI]

i Boes - = Bicse semen e

i E D5pazn BR D C/Sub DSPES00HC [C] 1]

5 B osraonn B 0 tain DSP000 L] H5

£ &l DSP5000C B osreomn( | psPaE0n0 R 55

£ B psesson Hriz Analogue [passive] [Fi] | Phono

— E& DSPE500HC HFiz Analogue [passive] [L1] | Phono

2 B psreoon

E B psProo0 L

— B psraoon

£ [ srslogus [active]

2 B tnalooue Ioassivel . . q g
Displaying or changing the speaker properties

* Drop it onto the appropriate speaker position. To display the speaker properties right-click the speaker symbol,
then click Properties on the context menu, or double-click the
Adding a speaker at a specific position speaker symbol:
@ e Right-click the position, point to Insert on the context menu, @
then click Speaker... on the submenu:
General | Connections |
Model: Generic
Type:  Analogue subwonfer

Active: Ve

g | + [N

1 Location:  Front centre

| Connections b Source el 4

,,,,,,,,,,,,,,,,, : Fole:  LFE/Centis/LFE
Arplfier,

Other Product...

Praperty [ Value |
. . . . . % Gain® 0.0d8
Alternatively, double-click or right-click the speaker position. $ S 2
EH Phase Pasitive
T width Namow
% Distance® | 140"

Reviewing and printing the source and speaker

Cancel

connections

Additional Speaker connections and Controller connections
pages can be displayed to allow you to check the source and
speaker connections, or print out a copy for help in wiring up the

system.

You can edit the properties in the same way as for source
properties.

 On the View menu, click Review Pages.
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Quick tour

Soft keys
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The Soft keys page allows you to customise the soft keys for each
of the G Series products in the system, starting with the controller.
In this example the only applicable product is the G68ADV.

An initial recommended layout is provided for each product; for
example, for a G68 this provides soft keys for each of the sources
in the system, plus a DSP key in the rightmost position.

o (lick the Next link in the Breadcrumb Trail to proceed to the
next page.

fian Configuration Program - Untitled [668ADV soft keys=]
Insert_Help

=lof x|

e =S s|m[E] - =[N G

disabled.

d drop key functions from the lefthand pane to assign
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Advanced tips

Changing the soft key layout
* Drag a soft key, or pair of keys, from the left-hand pane onto the
set of soft keys you want to edit:

Button Button2 Button3 Buttond Buttors

Jourt + J Cops

-+ [ I I N
s« [ I I R B

e Hold down to insert the key(s), moving existing keys right to
make space.

You can undo or redo changes to the soft key layout by clicking the

Undo or Redo buttons in the toolbar:

IR a‘f.lll%ﬂl'f‘?@

The first 12 soft keys correspond to the 12 MSR+ keys. Only the

ones corresponding to the sources you have defined in your system

will be available — the others will be greyed out. Their names will
reflect the names you have given to the sources on the Products

page.

Soft keys that work in pairs, such as balance, bass, treble, and
bright, automatically occupy two adjacent soft key positions.
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Renaming a source
e Right-click a soft key corresponding to a source, then click
Rename Source... on the context menu:

ALy

All occurrences of the source in the soft key sets will be changed.

Clearing a soft key

o Right-click the soft key, then click Remove on the context menu:

LSP

Restoring the recommended layout

e Click the Reset button for a recommended assignment of soft
keys.
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Bass management

‘ ‘ Configuration Guide.indb 20

The Bass management page specifies how bass is handled in
the system for each of the three speaker layouts. The settings are
automatically set to recommended values and can be ignored for a
simple configuration.

Advanced tips

Meridian digital surround controllers allow you to define three
different speaker layouts for use with different types of material:
Music, Logic, and 5.1 Movie. The Bass management page
allows you to specify how the bass is handled in each speaker
layout:

(4) Meridian Configuration Program - Untitled [Bass management*] (= |

Ele View Insert Help
DEME E =3 E‘,\\R’.’@‘
‘Stast > Products > GEBADY soltkevs > Mo

@ This page. optiens. T for each lapout.

Music | Logic | 51 Movie |

Crossaver B0H: =] LFElowpassfterFal =]  [Hesel )
Main sp
Fionts: [Lage ¥ # Mono

- & Mulichernel
The front speakers wil be used None © 2.charnel
for full cange reproduction.

I Display bass flow

Cenie [smal - Fiont suboofer

Bass for the certie speaker wil Bassheavy (monol 7.

be rediccted o subwoolers.
THX [~ Surtound sp

Al subwooers ate THX Uilia

4 =
P mioved. o it to 20 Hz Bears: [Small Fn?f’\? ;ZEVL?EZVEE::S]S willbe redirected to subwoolers
I Boundary gain compensaion plav

THY Defauls|

Specifying which speakers should handle the bass

The Main speakers and Surround speakers sections allow you
to specify whether each speaker is Large, in which case it will
handle the bass for that channel, or Small, in which case the bass
for that channel will be redirected to another speaker.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.

You can choose whether the main front and centre speakers are
specified as Large or Small for each of the Music, Logic, and
5.1 Movie speaker layouts.

The diagram to the right of each tab represents the selected
speaker layout; select Display bass flow to display red arrows on
the diagram indicating how the bass for each channel is handled by
the speakers in the layout for either Multichannel or 2-channel
sources as specified (see below).

Specifying which subwoofers are used in the layout

In the Subwoofers section you can specify how many of the
subwoofers are used in the layout. Subwoofers used in the
layout are indicated by a black square in the layout diagram, and
subwoofers not in use are indicated by a white square.

If there are no subwoofers in the layout the front speakers must
be specified as Large, and they will handle the bass for any other
small speakers in the layout.
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If there is one subwoofer in the layout, and you have specified the
front speakers as Small, the subwoofer will be used for the bass
and LFE. If the front speakers are Large and the centre speaker is
Small, the Front subwoofer option allows you to choose from
the following options:

Option Use of subwoofer

LFE Only * Handles just the LFE.
Bass-neutral (centre) Handles all the bass.

Shares the bass with the front
speakers.

Bass-heavy (mono)

* Not available for the Logic layout.

If the layout includes two or more subwoofers, the subwoofers will
handle the bass and LFE for the system irrespective of the size of
the front speakers.

Specifying the crossover settings
For each speaker layout the Crossover option allows you to set
the crossover frequency for the subwoofers. This is ignored if the
subwoofers are only handling the LFE.

The Meridian digital surround controllers provide very high-quality
crossovers for the subwoofers, and for best results you should

use these instead of the subwoofer's crossover. To do this set the
subwoofer Width property to Narrow, and remove any crossover
in the subwoofer, or set it to the highest setting (eg 200Hz). If
you cannot do this, set the subwoofer Width property to Wide to
switch off the digital surround controller's crossover and use Sine/
Sub mode to match the subwoofer’s crossover frequency.
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The LFE low pass filter option sets the low-pass filter for the LFE
channel, for the Music and 5.1 Movie speaker layouts.

e Click the Reset button to reset the crossover and low-pass filter
to recommended values in all layouts.

Specifying the THX settings

The THX settings tab allows you to specify that your subwoofers
are THX Ultra2 approved, and select Boundary gain
compensation to reduce bass levels if listeners are close to a
wall. Click the THX Defaults button to set the crossover and low-
pass filter to 80Hz in all layouts, as recommended by THX.
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Speaker distances
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The Speaker distances page gathers information about the
relative positions of the full-range speakers in your system, and the
distance of each speaker from the listening position. First choose
the units you would like to work in.

¢ On the View menu, click Metric or Imperial.
o Measure the distance to each speaker in the specified units.

e Drag the speakers until they are in the correct positions, with the
correct distance shown on each speaker icon.

This information is used to calculate the speaker delays, and
generate the aspect ratio and rear speaker separation.

Advanced tips

o Click the A or ¥ buttons to the left of the scale indicator to
change the scale of the whole diagram.

e Click a speaker to select it, and then use the arrow keys to move
the speaker in the corresponding direction.

e Use and to move a speaker away from or
towards the listening position. Hold down to move all the
speakers at once.

e Use and to move a speaker in a circle around the
listening position.

o Click the Scale to Fit button to increase the scale so the
loudspeakers fit neatly in the window.

(1) Meridian Configuration Program - me.ms! [Speaker distances™] —[olx|
Fle View Inset Help

DS H[E[es 3[m[E@NE]

Statt> By

@

T
Sedetoft | o F—r——F—

DSPEGOCHL|
Fiort ceriie
e

DSPe0D
Fiont eft
(2

&

<5} Rear speaker separation=18 " aspect ratio=1. 41 (Deepe than i is wide) 4

o (lick the Next link in the Breadcrumb Trail to proceed to the
next page.
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Speaker calibration

The Speaker calibration page allows you to calibrate the
speakers attached to your controller while listening to the product.
You can use the Meridian Configuration Program to step between
speakers, and change the properties of the currently selected
speaker, using the on-screen buttons.

To connect the serial cable
e Connect one end to the RS232 connector on the back panel of
the controller in your system.

e Connect the other end to one of the serial ports on your
computer.

The default is COM1. If you have to use a different port see
Advanced tips overleaf.

The Speaker calibration page shows a list of the speakers
connected to your controller and the current distance, level, and
phase settings of each speaker:

/M) Meridian Configuration Program - me. ms! [Speaker calibration®] =}

Fie View Inseit Help

DEHE& += s 5=m[ERT]

Stat > Products > GEAAD soft keys > > Spesker ditances > Speaker calbustion > Nent

hi i 0 , click Start. 0
e sired i he GEBADY. v canchange speaker prapetie ing e o parel, he HSF o e conkoks on s poge. You can asa change speaker
e umm by wdting your speskers ot this stage, vou may proceed to

Fioasecrte Ut st cale & comectad o) COMT on s corpue o s GEGRDY. Wher [
0 o ey, ik S

Calibiaion Orcer | Speaker [Distance [Level [ Phase [size

1 DSPEON0[L] 130" 008 Postve  na

2 DSPES00HC (0] 130" 008 Pestve  wa

3 DEPE0OD [F] 1300 008 Posive  n/a
4 Andogue [passive] (F1] 130" 008 Postve 17
5 Andonue [passive] 0 13707 008 Postve 17
@5 Subwooter [C] 130 008 Pestve 28

o (lick the Start button.
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The Meridian Configuration Program stores the settings you

have created to the controller and then automatically starts the
calibration sequence so you can tune your speakers by ear using a
series of listening tests:

) Meridion Configuration Program - me.msl [Speaker calibration’] ML=

Fle Miew Insett Help

DEE S «=s 5= /EFNI)]

Stat > Products > GB3ADY soft keys > Bass management » Speake distances > Spesker odlibnalion » Nes!

This page is used to hed to the GEBADY. clck Start, Onc:
are siored to the GBBADY. you can change speaker propertiss using the fiont panel. B oo s P e A
Sl et 6 S ST o N o g LA o o S B o
et pace.

- ) g
Storing =
witing setings.

Ficading documents.
E rasing memor.
Storng documents.
€ tering calibration mode.
Wamng for product to reset.
e 861 should now reset nta Calbration Mode
\)P\ease cailrate the 961 a5 descibed i the product manyal
ey have frihec,cick Exton s page o press Wit the 857 ot parel orcn e

o Use the €, D, A, and ¥ buttons on the Speaker calibration
page to control the product; refer to the appropriate guide for
your product for details of the calibration procedure.

The product’s display is shown above the arrow keys on the
Speaker calibration page.

e \When you have completed the calibration procedure click the
Exit button on the Speaker calibration page, or the Off
button on the product, to fetch the calibration settings from the
controller.

The calibration settings will be shown in the speaker list on the
Speaker calibration page.

o Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Quick tour

Options
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e |
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Room correction

The Room correction page runs the Meridian Room Correction
procedure. This is optional and you can skip this stage by clicking
the Next link in the Breadcrumb Trail:

1) Meridian Configuration Program - me.ms! [Room comectiont]

=10/ x|
File View Insert Help

D[S [+=3 3= ENE

Start > Products > GEBADY solt keys >

Speaker dstances > Speaker cabvation > Aoom conecion > Next

et You can alsa right |

Click O ptions to veiiy the microphone sersitviy and the input to which it i connected. Clck
and store profies to the product. lickin view,
Conigt 1f you do not wish to i

Start. ... toperfom measuemerts, build conection fters,
nge. is. For see the

4 to the Phnext page,

Measurements | Profes |

Options.
‘ s

Measuement Set_| usic | Logic/5.1 Movie |

Na measuements are present. Dlick Start... to perform measurements, buld conestion fles and a
profile that wil be stored o the product. Altermalivel, richt-cick to creale a measurement
manuially.

For information about running the Room Correction procedure see
the chapter Room Correction, page 31.

o Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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DSP presets
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The DSP presets page shows a list of the DSP presets available to
the digital surround controller, and allows you to edit the properties
of each preset. You can also edit the preset mappings, to change
the default DSP preset selected for each source and each audio
format.

Advanced tips

The Preset Properties pane shows the name and value of each
of the preset properties:

~ Pieset Properi
23 All presets Praperty alus
|- Direct % Balance [
: Music & Cortre lsvel node
 Titield £ Centre depth 1.0ms
2 Ambisonics 2 Rear delay 0.0ms
: %
gt“:':’u % Ficar level 0d8
 MusicLogic EAE Rear LPF of
 Mano % Lipsyne 0.0ms
¢ TV Logic ¥ HS out Yes
£ PLI Music Fioom correction profile | Bypassed
¢ FLI Movie || % LFE lswel nds
Compression Compress off
B Surmound option Rears
8 Music 2
| | B

Some properties apply globally to all presets; to edit these select
All presets in the Preset Properties list.

Displaying and changing the properties for a preset
o Select the preset in the left-hand list.

You can then edit the properties in exactly the same way as for
product properties; see Changing the value of a property, page 9,
or Reverting a property to its default value, page 9.

For full information about the parameters for each DSP preset see
the Installation Guide for your product.

For a simple configuration you can skip this page.

o (lick the Next link in the Breadcrumb Trail to proceed to the
next page.

Creating user-defined presets
You can create additional user-defined presets with specific
properties:

e Right-click the preset you want to use as the basis for the new
preset, point to Copy to on the context menu, then click New
Preset on the submenu:

Pevert to Defauits |
Mew Preset

Preset "Music 2"

Revert &l to Defaults...

If you have already created one or more user-defined presets, you

also have the option of overwriting an existing user-defined preset.

Restoring presets to their default values
e Right-click the preset, then click Revert to Defaults on the
context menu:

T

Lopyto

Fevert 4l to Defaults...

o Alternatively click Revert All to Defaults... to revert all the
built-in and user-defined presets to their default properties.
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Quick tour

Tuner presets
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For each product in your system that includes a radio tuner, a
Tuner presets page allows you to define the legend displayed on
the front panel display for each tuner preset, and the waveband,
frequency, and audio mode it selects:

1) Meridian Configuration Program - G68ADVa.ms! [GEBADY tuner presets’] -3 x|

File View Inset Help

DEE S| e = EN

Start > Produts > GEBADY solt keys > Bass management > Speaket calbration » Speaker distanes > Floom conection > DSP pressts > GEBADY tunet preses >
Next

@ This page shaws the tuner presats. Ta enable a preset. check the bai o the left then change its characteristics by clicking on the values inthe cther

Mumber | Legend | Waveband | Frequency | DisplayLegend | Audiobode [ a]
[=H] Radiol | FM 880MHz  Yes Stereo
2 Radio2 | FM B33MHz  VYes Stereo
3 Radio3 | FM SLIMHz  Yes Steren
4 Radio4  FM 88.8MHz  Yes Stereo
5 FM G75MHz Vs Stereo
Oc Enply
O Empy
Oc Enply
Os Emply
Oo Empy
O Emply
[mRE Emply
[mEE] Emply
O Emply
[=EE} Emply
[mEE] Emply
O Emply
O Empy
[mRE] Emply
O Emply

Tuneregin: [0t = 5

o (lick the checkbox in the Number column to enable the
corresponding tuner preset, and edit the Legend, Frequency,
and Audio Mode as required.

o Set Display Legend to No if you want the display to show
the RDS station name, or frequency if no RDS station name is
available, rather than a predefined legend.

When you have edited the tuner presets as required:

o Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Store settings

This page stores the settings to the controller:

4/ Meridian Configuration Program - G684DVa msl [Store GBBADY seitings™]

Ele Vew Inset Help
DS E 5|« = EFW
Start > Products > GBBADV soft keys > Speaker calbration > Speaker distances > DSP presets > GEBADY tuner presets >
Store GEEADY seting: > Ne
@ This page is used to store settings to the GERADY.

(5 Plase e ha o s cable s cornected om CONT on o computr o the GESADV. Wher | [ Opions
you are ready, cick Statt
[
I sz types

@ o Connect the serial cable.

For more information see To connect the serial cable, page 23.
o Click the Start button to store the settings.

When the store has completed:

e Click the Next link in the Breadcrumb Trail.
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Finish
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The Finish page confirms that you have successfully completed the
configuration of your system.

Save a copy of your configuration

Although a copy of the configuration document is saved in the
controller for your system, it is recommended that you also save

a copy of the final configuration document on your PC, with an
appropriate name, so that you can refer to it again at a later date,
if necessary.

® On the File menu, click Save, or click the Save button in the
toolbar:
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Room Correction

The G68 and 861 digital surround controllers incorporate room correction, which takes
advantage of advanced digital signal processing techniques to compensate for room artefacts,

including resonances and reflections, to give a significant improvement in the sound.
This chapter explains how to use Meridian Room Correction to create profiles for use with the
digital surround controller.

Room
correction

Introduction

The Meridian Room Correction procedure creates a set of one or
more room correction profiles matched to your room. These are then
downloaded to the digital surround controller and can be associated
with particular presets, or selected from the front panel. Selecting a
profile applies a set of digital filters individually to each speaker to
achieve the required room correction.

If you use a single speaker layout you may choose to have one
room correction profile, and use this with all presets. If you have
separate speaker layouts for use with Music, Logic, and 5.1 Movie
sources you will need to calculate a separate room correction profile
for each speaker layout. These will then be selected automatically
by the digital surround controller depending on the audio format. In
addition, you can create separate room correction profiles to take
account of changes to the room, such as the position of large items
of furniture, or with curtains open or closed.
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How room correction profiles are
calculated

Calculating a room correction profile is a time-consuming and
mathematically complicated process. Meridian Room Correction
performs the necessary sequence of measurements and calculations
automatically, using a PC connected to the digital surround
controller, with the minimum of interaction. It works as follows:

First you need to set up a microphone close to the listening
position, and connect this to an appropriate input on the digital
surround controller. On the G68 Digital Surround Controller this will
be A8 (L). On the 861 Reference Digital Surround Controller this can
be any analogue input; input A1 on card IAQO is chosen by default.

Usually a standard sound pressure level meter will be used as a
microphone; this can be the same one used for setting the speaker
levels during the Calibration procedure. After an initial short test
sequence, designed to check that the microphone is set up correctly,
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Room

correction
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a test signal is presented to each loudspeaker and measured at the
microphone to determine how the room response affects the sound
from each speaker. This stage of the procedure takes about one
minute per speaker, and can be left to run unattended.

Finally, after a complete set of measurements has been made

for each channel and speaker layout, the program calculates a

set of filters for each channel, and stores these to the digital
surround controller. A copy of the measurements, together with the
calculated filters in each profile, is also stored on the PC so they
can be accessed at a later date if required.

Examples

Most domestic rooms tend to be rectangular, or at the very least
have one pair of parallel facing walls, and unfortunately these are
the ideal conditions for low frequency resonances within the room.
The wavelength of low frequency sounds is relatively large, so even
bookcases and curtains act as an almost perfect mirror for low
frequencies.

Frequencies close to the resonant frequency, determined by the
distance between the two reflective surfaces, will sound louder and
take longer to decay than other frequencies. In practice this means
that when listening to music some notes will sound louder, giving a
roughness or unevenness to the sound.

Other problems that can be corrected by room correction are
imbalances between the speakers due to positioning constraints.
For example, in an L-shaped room one loudspeaker may need to be
close to the wall whereas its partner is in an open area, giving rise
to an imbalanced sound field.

Unless your listening room has been specially designed for acoustic
performance, you will almost certainly hear distinct benefits after
incorporating room correction into your digital surround controller,
and if the room has major resonances or imbalances the difference
should be quite dramatic.

You can find more information about the theory behind Meridian
Room Correction on the Meridian Web Site at:
http://www.meridian-audio.com/p_rc.htm
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Auto Build

This section explains how to create a basic room correction using
default settings.

The room should be as you would normally use it for listening.
Close/open doors, close/open curtains, and position your screen
and furniture as they would normally be for listening.

If you are creating room correction profiles as part of the initial
configuration of your system, follow the procedure described in
this chapter when you get to the Room correction page in the
sequence of Meridian Configuration Program pages.

If you decided not to create room correction profiles when you
first configured the system, start from the saved configuration

file, or fetch the configuration from the digital surround controller,

and then step forward to the Room correction page in the
Breadcrumb Trail:

(1) Meridian Configuration Program - me. ms| [Room correction®] I =] 7]

File View Insert Help

DER |5 =S

BT

Start> Products > GBAADY soft keys > Bass management > Speaker distances > Speaker calbration > > Hest

Ciok Optians to vy e nitgphonsseriyly and e o which s conecied Clck Start... topatom nessuenents, bl creton s,
‘and store profis to the product. You can also right-click in list o view, a
Corigaation Piogram Gt I you o 10k wih to ptfom i Cotcton a is stage, pocesd 1 the B e

Measurcments | Profes | Options
[Music | Logie/51 Movie | St

No messurements are present. Click Start... 1o perform measurements, buld correction fles and a
profil that will be stored 1o the product. Altemativel, right-cick to create & measuremert
manualy.
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To set up the room correction options
The first step is to specify options for the room correction
procedure.

o Click the Options...
options:

button to display the room correction

[EET—— 21

General | Serial Port| Colows Fioom Conection |

Microphorn
Please ensure that the microphane is
[ﬁa”s“““w [ (S output A8 [Mic]

Maximum measurement retries: |3 _,;

3 Cancel

o Specify the sensitivity for the microphone.

When first running room correction it is recommended that you
leave this at its initial setting.

If you are using an 861 Reference Digital Surround Controller you
will also need to specify the card and input you are using for the
microphone.

o Specify the maximum number of measurement retries; by default
this is set to 3, but you can enter a lower value to reduce the
time taken by retries.

o Click the OK button to confirm the options you have specified.

Room
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e If you are using a G68 Digital Surround Controller connect the
SPL meter or microphone to the analogue input A8 (L).

e If you are using an 861 Reference Digital Surround Controller
connect the SPL meter or microphone to the analogue input you
specified in the Options dialogue box.

e Position the SPL meter or microphone at the listening position
and, if you are using an SPL meter, switch it on.

When using an SPL meter, the C weighting must be used. The 90dB
range is recommended unless the loudspeakers measured less than
75dB SPL during the calibration, in which case the 80dB range is
recommended.

To run the Auto Build procedure
o Click the Start... button.

A countdown dialogue box will give you time to leave the room:

@ i
During each measurement there wil be a period oflaud noise.
You may wish ta leave the aom at this poirt.

Cancel

A test tone will then be presented to each loudspeaker in turn
for each of the distinct layouts defined in the digital surround
controller configuration file.

Depending on the number of channels and layouts in your
configuration this may involve up to 24 tests and take up to 20
minutes to complete.

The Room correction page shows information about each test
and a progress bar indicates the percentage completed:

(1) Meridian Configuration Program - 861a.ms! [Room correction®] —[ofx|

G Wiew lnseit Help

DEH &S =38

Stait> Products > > Speake: calbistion > Gpesker ditances >

senslivly and Joutest the

microphane (to do this click the Test Mic bution). Ciick Auto Build. in every layout,
tight-click inthe. . ackd or change . 1f you do at this st L
Measuremerts | Prfies | Dptiors
Messrement Set_| Music Logc 51 Movie Sat
Pio No charels measured o chan e mea: ]|
4 1 M
N

Statting measurement of Front left [Music/Lagic/5.1 Mavie layoul, =l
Seting voume o 87
MLS me suremert
Caluistingimpuise resporise:
Caleultion complete; pevwer=23d8, SHR -35c8
Setiing volume o 50.

Reselling to measurement madk.

Trasferting data. =

When the measurements have been completed the following
dialogue box allows you to apply the room correction profiles:

Apply Room Profiles Jied |

Dia you wish to apply the profiles you have crested to sl pressts?
If you choose Yes, each preset wil be assigned the [ast profile valid for its DSP made

S

I~ Remember my decision [don't ask me again]

e Click the Yes button to assign an appropriate profile to each
preset.
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Each preset will be assigned the profile designed for the layout
used with the preset. The wizard creates profiles called Mus, Log,
and Mov for the Music, Logic, and 5.1 Movie speaker layouts
respectively. If two or more layouts share the same settings, the
profile name will include all the layouts it applies to; for example,
MusLog or MusLogMov.

What next?

You have now completed the Auto Build procedure, which creates
a recommended set of room correction profiles. In most situations
this is all you need to do in order to take advantage of room
correction with your digital surround controller.

The next sections describe some of the more advanced options
available on the Room correction page, including the options
for re-measuring channels, selecting different filter parameters, and
manually editing the filters.
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Viewing and repeating measurements
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The Measurements tab shows a list of the measurement sets you
have created. Each measurement set shows the channels measured
for each of the speaker layouts set up in the digital surround
controller configuration:

Measuements | Profies |

1Set | Music [ Logic [ 5.1 Movie:
P Messuement  LACLFELsRsLtAr  LACLsAsLcAr  LALFELsAs iRt

You can also create additional measurement sets; for example to
cater for different furniture layouts. For each measurement you can
view the effect of applying different profiles.

The Measurements tab gives you the option of viewing

or comparing the measurements. You can also repeat the
measurements for individual speakers; for example, if an external
noise interfered with the test procedure.

To view the measurements
e Right-click the measurement you want to view, then click View
Plot on the context menu, or double-click the measurement:

] Hew

Bename
¥ Delele

P Measure...
Pe-measure

=

The Plot Measurement window allows you to see the
measurement for the specified channel:

(11} Plot Measurement - Measurement - Logic - Front left =[] x|

chaee: TR ) (][] | s

WiateitallPlot | Low Frequensy Respanse | Impulse Response |

Frofie:[Bypazsed =

Laveal (dB|

-72.0

-20.0

—@o.0

-100.0)

Frequency (Hz} 3

e Select the profile from the Profile drop-down list.
To show the uncorrected response select Bypassed.

You can compare the effect of two Profile settings on the same
plot by clicking one of the split pane buttons:

Bl m
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-80.0

-90.0

-130.0

You can then set different Profile settings for each plot:

(v} Plot Measurement - Measurement - 5.1 Movie - Front left -10(x|

B ol Ol | se

Wateifal Plot | Low Frequency esponse | Impuise Response |

JE— =

You can select one of the following three graph types by clicking
the corresponding tab. All three views of the measurement are
calculated from the same measured test signal:

Waterfall plot

Waterfall plot

Level (6B)

-100.0

-110.0 0.00

0.25
0.50

-120.0 0.75

1.00
251 (sec)
1.50

0.0 s0.0 100.0 150.0 200.0 2500
Freq. (Hz)
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Shows the response of the room to a series of short sine wave
pulses of frequencies between 0 and 250Hz. It shows how the
response decays over time at each of those frequencies.

The ideal waterfall plot would have a smooth profile and decay
evenly to a low level within 0.5 to 0.8 seconds. Peaks or dips
in the waterfall plot indicate resonances or absorption at the
corresponding frequency. Ridges extending forwards in time
indicate reverberation at the corresponding frequency.

The room correction profile aims to identify the strongest
resonances and to reduce the decay time of each strong resonance
to the average decay time for the room.

Impulse response

Arnplitucle Impulse response

0.0028

0.0025

0.0020

0.0015

0.0010

0.0005

0.0000

-0.0005

-0.0010

-0.0015

-0.0020

-0.0025

-0.0027

0.0 1.0 2.0 3.0
Time (sec)

Shows the response over time of the loudspeaker to a click. The
curve shows a maximum just after time zero, and then decays
rapidly depending on the amount of reverberation in the room. Any
additional peaks in the response indicate resonances set up by the
initial impulse.

Room
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Low frequency response

Level (dB) Low frequency response

S
N AL 3
// i) W

-120.0

N
|

0.0 50.0 100.0 150.0 200.0 250.0
Frea. (Hz)

Shows the loudspeaker-room response to a low frequency sine
wave, swept between 0 and 250Hz. The ideal low frequency
response would be smooth. A peak in the response indicates a
resonance at the corresponding frequency. A dip in the response
indicates absorption or cancellation at the corresponding frequency.

To display the value of the curve at any point
e Drag to position the vertical red cursor.

The values of the curve at the current point are displayed in the top
right-hand corner of the plot:

(1) Plot Measurement - Measurement - Logic - Front left =[3l x|
charet [ENENS] 5] (D] [T &

Walerfall Plot. Law Frequency Rizspense | Impuse Response |

Level (dB) Frofie:[Bypaseed =

-74.0
-76.0

O T 1
ATERYSEI WA
gl N A
L |
WN\V/

0.0 s0.0 100.0 150.0 200.0 2s0.0
Frequency (Hz)

TEo. 1 (=)
sma.s (aE)

In the Waterfall Plot the values displayed correspond to Time = 0.

To change the axes
o Click the Axes... button to display the axis parameters.

The Data Range section on each tab shows the range of the data
measured by the Room Correction procedure.

The View Range section on each tab allows you to set the range
of the Frequency, Level, Time, and Amplitude axes as appropriate
for each plot:

Daata Flana: Yiew Flang
Freguency: 0.0000 to 2600000 He Frequency: [0.0000 =] to [250.0000 =] Hz

Level: -220.0000 to -78.0000 dB Level —17500003: to |-78.0000 = dB
Time: 0.0000 to 1.5000 sec Time: 0.0000 3: o |1.5000 3: sec

To repeat measurements

You can repeat measurements for one or more channels;
for example, if an external sound interfered with an existing
measurement.

e Right-click the measurement you want to repeat, then click Re-
measure... on the context menu:

Eename
¥ Delats

P Moz

) iew Flat
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The following dialogue box allows you to select which channels To create multiple measurements
you want to repeat: You can create additional measurement sets to take account of
different configurations of the room, such as with curtains open or
Speakers to Measure 2] x|
o closed.
@ lsase select the speakers to be [remeasured
Cancel
Chamnel | Lapouts [Stotus ] e Right-click the Measurements tab, then click New on the
[ Front left Music/Logic/5.1 Movie  Measured
[w] Frontright  Music/Logic/5 1 Movie Mot measured context menu.
Music/Logic/5.1 Movie Mot measured
Muzic Mot measured
Music/Logic/5.1 Movie Mot measured
Muzic/Logic/5.1 Mavie Mot measured H H
D i messed A new measurement set will be added to the list, and the
Speakers to Measure dialogue box will be displayed to allow
Measurement of the selected speakers will take approximately § minutes. you to specify Wh|ch speakers you want to measure.

« Select the channels you want to repeat. e Click the OK button to proceed with the measurement.

o Click the OK button to confirm your selection.
@ To rename a measurement set @

e Right-click the measurement set, then click Rename on the

The following dialogue box warns you that the existin
g g y g context menu, or press [F2).

measurements will be overwritten:
e Edit the name as required and press (<.

Overwrite Measurements X

“You have chosen to remeasure ane or more chanhels.

This will averwie any previous measurements. Confinue? To delete a measurement set
to e Right-click the measurement set, then click Delete on the
context menu, or select the measurement set and press [Del.

o Click the Yes button to continue, or the No button to retain the
existing measurements.

The following dialogue box then indicates how long the selected
measurements will take, and gives you an opportunity to leave the
room before the test sequence begins:

[ 2 x|

@ The measurements wil tske apprasimately B minutes to complets

During sach measwiement there will be & period of loud naise:
*You may wish ta leave the rwom at this paint.

{ Beginiid] Cancel
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The Profiles tab shows a list of the profiles that have been
calculated, together with the number of filters used for each profile
and the number of remaining filters available:

Measuements  Prafilss |

Profie name | Lapout | Fiters || Available

L BHovie
<) Logic

< Music

Each profile can use up to 60 filters; if a profile requires more
filters than this, filters will be allocated in order of priority.

Each channel is limited to a maximum of 20 filters; a two-channel
system therefore has a limit of 40 filters.

To build the filters for a profile
e Right-click the profile in the Profiles list, then click Build... on
the context menu:

The following dialogue box then allows you to specify a target
decay time:

[Target Decay R
If you choose a manual target decay ox
Qe Loy
100 and 1000 millseconds finclusive], Cancel
 futomalic
€ Manual [0 = msec

o Leave Automatic selected, or click Manual and enter a delay
time between 100 and 1000 milliseconds.

e Click the OK button to continue.

If you have more than one measurement set the following dialogue
box is displayed to allow you to select which measurement set you
want to use for the filters:

Build Filters - Select Measurement Set 2=l
|

Measurement Set ()3
|M
Cancel

SofaL

Note: The process of building filters is computationally intensive,
and it is recommended that you do not try to run other programs
at the same time.

As the filters are calculated the status is shown in the lower half of
the Room correction page.

To store profiles temporarily to the digital surround
controller

You can store profiles temporarily to the digital surround controller
so you can listen to them while using Meridian Room Correction.

e Right-click the profile in the Profiles list, then click Store on the
context menu.

The lower half of the Room correction page shows the progress
as the profile is stored to the digital surround controller.
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Editing filters

After building the filters for a profile you can edit the filters
numerically or graphically to adjust their parameters, or change the
response of each filter.

Note: This should only be attempted by users with an
understanding of filter design. It is strongly recommended that you
copy the profile first and then edit the copied profile. There is no
undo function within Edit filters.

To display the filters for a profile
o Right-click the profile in the Profiles list, then click Edit... on
the context menu, or double-click the profile in the Profiles list.

The Edit Filters window shows a numeric or graphical display of
the filters in the profile.

e Choose a channel from the Channel drop-down list to display
the filters for that channel, or choose All Channels to show all
the filters for all channels on a single display.

To view the filters numerically
o Select Numeric.
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The columns give the Centre Frequency (Hz), Gain (dB), Filter
Bandwidth (Hz), Room Mode Bandwidth (Hz), Equalized Bandwidth
(Hz), RTg (s), Target RTg) (s), and Channel:

+ Edit Filters - Movie - 5.1 Movie

B —
Chanret [Fromien =] | [

1+ Mumeric
' Graphical

@512] 22 62 55 71 0403 0311

Frequency: [510 =1 He |
& X

N T

¥

Gain: -8

49760 filters used.

5720 filtess used on this channgl

The fields on the left of the filters list allow you to adjust the
Frequency, Gain, and Width of the currently selected filter.

Room
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To view the filters graphically The currently selected filter is displayed with a red vertical bar
e Select Graphical: at the filter centre frequency, and a rectangle indicating the
bandwidth and gain of the filter.

+ Edit Filters - Movie - 5.1 Movie

; M ’ T . .

Ll [Froniett ] You can edit each parameter of the filter interactively as described

£ Numeric . . .

* Graphical in the following sections.
Erequency: [F10 =1 Hz =7
Gan  [o1 e ¥ Centre frequency
“wfidth; 2B = H . . .
:a'wn ; =™ e Drag the vertical bar to the left or right on the filter response
5/20 fikers s on i chanrel curve, or press [« or (=J:

0 20 40 B0 80 10012014C160180200220240
Freguency (Hz)
A
§ To edit a filter ol %
o Select the filter you want to edit by clicking on the filter: ' '

Gain
e Drag the base of the filter, or press (1] or [1]:

Alternatively if the filters are close together you can step right or

left between filters using or (Ctrl) (Shiff)(Tab).
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Bandwidth
e Drag one of the sides of the filter, or press or Crl(=]:

7
U

To add a filter
o Click the Add button on the Numeric or Graphical tab:

o Edit the parameters of the filter as described above.

To delete a filter
o Select the filter you want to delete in the Filters list, or on the
Graphical tab.

o Press (Del], or click the Delete button:

X
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Changing settings at a later date
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This section describes how to change the room correction or
configuration settings of the digital surround controller at a later
date, subsequent to storing the original version.

Note: You can only edit or add to existing profiles if you have the
MSL file originally used to design the profile. If you do not have the
original MSL file you will need to make new measurements, create
new profiles, and then store these to the digital surround controller.

To edit an existing profile, or add a new profile

 Run the Meridian Configuration Program and open the MSL file
used to create the original profiles.

If you have changed settings on the digital surround controller
since the original profiles were made, and you want to retain these
changes:

® On the File menu, click Save as to save the MSL file under a
new name.

To fetch the settings from the digital surround controller:

¢ On the Products page, right-click the controller, then click
Fetch... on the context menu.

e Step forward to the Room correction page in the Breadcrumb
Trail.

e Select the Profiles tab, and proceed as described in Editing
filters, page 41.

To change other settings if you have the original MSL file
e Run the Meridian Configuration Program and open the original
MSL file.

If you want to keep the original settings:

* On the File menuy, click Save as to save a copy of the MSL file
under a new name.

e Change the settings as required and store the new settings to
the digital surround controller.

For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide
for your product.

To change other settings if you have lost the original MSL
file

If the original MSL file is not available you will be able to change
all non-room correction settings, and which room correction profile
you want to use with a given preset.

e Start a new document.

 On the File menu, click Fetch... to fetch the settings from the
digital surround controller.

The newly created file will contain the profile labels and these can

be used to choose the profile you want to use with a given preset.
It will not contain measurements or profile data for Meridian Room
Correction. If you use Meridian Room Correction to create new
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measurements and profiles and store these to the digital surround
controller, the old profiles will be overwritten.

e Change the settings as required and store the new settings to
the digital surround controller.

For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide
for your product.

To change other settings directly on the digital surround
controller

For information about changing other configuration settings on the
digital surround controller refer to the Installation Guide for your

@ product. @

After making changes on the digital surround controller you can
add these changes to an existing MSL file as follows:

® Run the Meridian Configuration Program and open the original
MSL file.

¢ On the Products page, right-click the controller, then click
Fetch... on the context menu to fetch the new settings from the
digital surround controller.

If you want to keep the original settings:

 On the File menuy, click Save as to save a copy of the MSL file.
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Troubleshooting
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This section gives suggested solutions to typical problems that
may occur when using Meridian Room Correction. If problems
still persist after working through the following steps please send
an email to support@meridian.co.uk with a zip file containing
your MSL file. Please also supply details of the loudspeakers and
amplifiers you are using.

Failed microphone/SPL meter test

During the first measurement a microphone test is performed
to ensure that the power and SNR (signal to noise ratio) are
acceptable. The larger the SNR the better the measurement.

The following sections describe some of the most likely problems
which will cause the power and SNR values to go outside these
ranges.

Power result “Bad”
This indicates that there is very little or no signal on the connector
you have chosen as your microphone input.

e Check that there was sound from the front left speaker during
the test.

If in doubt, repeat the measurement. If there is still no sound check
the connections from the digital surround controller to the left
loudspeaker. Switch the digital surround controller off and then

on again, select Calibrate as described in the installation guide
for your digital surround controller, and check that the left speaker
plays the calibration signal.

e Ensure that the lead from the SPL meter is intact.

e Check that the SPL meter is switched on and set to the 90dB
band, or the band which includes 90dB, and with C weighting.

If the loudspeakers measured less than 75dB SPL during the
calibration phase it may be better to use the 80dB range.

e Check that the lead from the SPL meter is connected to the
correct input,
A8 (L) on the G68.

e Ensure that the Sensitivity setting is adequate for the SPL meter
or microphone.

The sensitivity value for analogue inputs is given in rms volts
(Vrms). For example, a sensitivity of 1Vrms allows a signal of
2.8Vpp. A sensitivity of 1V is recommended for use with most SPL
meters though 0.7V may be preferable for those with lower level
output.

Power OK, SNR result “Bad”
The most likely cause of this problem is that an analogue source is
connected to the input chosen for the microphone.

e Check that the lead from the SPL meter is connected to the input
you have chosen for the microphone test.

Another possibility is that the lead from the SPL meter is in bad
condition and only making a poor connection.

Power OK, SNR result “Poor”
The reasons for this are described in detail in the following section
where example measurements are also shown.
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Repeated measurements due to poor SNR

Measurements are retried until the SNR is acceptable or the
maximum number of retries has been completed. The maximum
number of times each measurement will be retried due to poor
SNR can be set in the Preferences dialogue box, accessed from
the Options menu:

options T

General | Serial Port| Colows Fioom Conection |

Micraphon
’7§ard'IIAUU =l et a1 =] Sensitvite [10v =]
Masimum measurement ietries: |3 _,;

Cancel

The default number of retries is 3. If the measurements are
consistently giving poor SNR figures you can reduce the number of
retries. However, it is better to follow the steps described below to
improve the measurement conditions. The better the measurement
the more accurate the results when calculating the filters for a
profile.
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-0.00005.
-0.000104
-0.0001

-0.00020.
-0.000;

SPL meter is set on a low band

The following graph shows an impulse response obtained when a
Radio Shack SPL meter was set on the 60dB band. The SNR value
was “Poor”:

Amplituce Impulse response
0.034

0.030

0.025

0.020

0.015

0.010

0.005

0.000
-0.005

-0.010

-0.018

-0.020

-0.025

-0.030

-0.035

-0.039

o0 1.0 2.0 30 4.0 50
Time (sec)

SPL meter is set on a high band

The following graph shows an impulse response obtained when a
Radio Shack SPL meter was set on the 120dB band. The tail of the
response is generally noisy. The SNR value was acceptable but the
power was “Bad”:

Arnplitude Impulse respense

0.0001

0.00010

0.00005

0.00000

0.0 1.0 2.0 3.0 4.0 5.0
Time (sec)
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Loudspeaker is running in a non-linear range

The effects of a loudspeaker running in a non-linear range is most
easily observed in the impulse response. The tail of the response
has small spikes, as shown in the plot below, where it should be
zero. The larger these spikes are relative to the largest value at the
beginning of the impulse response the smaller the SNR value:

Amplitucle Impulse response
0.0020
0.0015
0.0010
0.0005
0.0000 / \
-0.0005 /1
-0.0010 ,
-0.0015 '
-0.0020 ,
-0.0025 ,
-0.0030 ,
-0.0032 |

0a 1.0 4.0 50

30
Tirne (sec)

e Check that the bass protection size has been correctly set — see
the Installation Guide for your product.

e Check that the bass drive unit in your loudspeaker is not rubbing.

e Check that your amplifier is not clipping.

If problems are still encountered, use the Speaker calibration
page to reduce the gain of the channel. Use the reduced gain
setting for the room correction measurements, then return to the
correct level for a calibrated system after running room correction
measurements.

Hum in the system

The effect of hum on the measurement is most easily observed in
the waterfall plot. The continuing signal at 50Hz and 150Hz in the
waterfall plot shown below indicates a mains hum loop:

waterfall plot

Level (@8

-850

0.0

1000

“1100

1200

1300

1400

1500 L2
o

Frea. (Hz)

You are likely to have heard this level of hum when playing
analogue sources connected to the same analogue input card as
the microphone/SPL meter.

In order to get a better measurement disconnect analogue sources
from the analogue input card used for the room correction
measurements. Reorganise your speaker wiring to remove the hum
loop.

Hum may also be picked up by the lead from the microphone/SPL
meter. It is best to use a shielded cable to reduce the chances of
picking up hum.

12/11/04 3:35:52 pm ‘ ‘



Control
Window

Control Window

The Meridian Control Window emulates an MSR+ to allow you to control a Meridian product
from a PC via a serial or USB cable.

Run n | ng the Mer|d|a n COI’]UO| The Meridian Control Window will be displayed:
@ Wl ndOW == Control Window 2lx| @

This window sends commands to the product attached to the senial — pisconmect
port of your computer. The aow, Enter and Backspace keps act  — b =
a5 shorteuts for menu operations e B

MR+ | MSF | Command |

e Click Start, point to Programs, Meridian, then click Control

Window:
CD Tifield €5

:]'J‘ED Fosio| V0| o | e T_Dlﬂﬂlil e veR2| Gane| ot |
é e ) My Documents 2| 3| B R TN
Internet Explorer
—— L‘bMy Recent Documents  » _I_I_I _Iﬂl_l _I—ILI_I
B ref e | Rem| v [Mew| Aot sun|ose| w| |
s | oftw| @] @] o ef s chromy el
E Microsoft Word J T @

‘H o ngy Computer s
O [T Accessories ¥ lork Places
) windows Media |5 administrative Tools »I . . .
- i T e This provides the following tabs:
L;J Calculatar ) Startup 3 Configuration Pragram
Wicrosoft Access | e
Wirosoft Excel WP & Tab Description

B Microsaft FrontPage
Microsaft Outiock . MSR+ Emulates an MSR+ Controller.
5| Microsaft PowerPoint e
Micrasoft Word MSR Emulates an MSR Controller.
W MSH Explorer .
B M Messenger 6.0 Command Allows you to send predefined commands, and
gl [B] un off compucer optionally specify arguments for the commands,

and then see the response from the product in a
terminal-style window.
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Emulating an MSR+ or MSR
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To send a command to the product
o Click the corresponding button on the Control Window.

The bar above the buttons shows the response from the product,
corresponding to the front panel display.

To enter a function key
Either:

e Click the Fn button followed by the button you want to enter.

or:

o Right-click the button or click the button while holding down
Ctrl].

The legends of the buttons change to show the function options.

To lock the Fn button down

o Click the Lock button:
=l

Subsequent button presses will then enter function keys.

Press the Lock button or Fn button again to release the Lock
button.

To see the command corresponding to each button
Each button transmits a two-letter code to the product.

e Point to the button with the mouse pointer.

A tooltip shows the description of the key followed by the key's
command:

Select CD source (CD]

You can also give commands by typing the key’s command on the
computer keyboard. Note: Commands are case sensitive.

For example, to select the CD source type CD.

In addition, the following keys on the keyboard provide shortcuts
for the menu buttons:

Computer key MSR button
.0 =2 AV 4>
Enter
(backspace) Return

To disconnect the Control Window
o Click the Disconnect button.

To connect the Control Window
o Select the COM port you want to use from the Port drop-down
list.

o Click the Connect button.

A warning triangle next to a port number indicates that it is in use
by another application.

To close the Control Window
e Click the Close button or press [Es.
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Using the Command tab

The Command tab lists all the available commands under four
headings: Source, General, Function + MSR keys, and Preset:

== Control Window 21x
This window sends commands to the product attached to the senial  picconnect Close
port of your computer. You can also type commands on the MSH = =
and M5R+ tabs Port [com

MSR+ | MSR Eommandl

=D
»PN3
CD  Ambisonics BS

[ Source
General
[#- Function + MSR keys
[=)- Presst
Go to preset
- Direct
- Music
Trifield

Send >

- Super
Stereo
- MusicLogic
=

jv

To display the commands
o Click the + button to the left of one of the headings to show the

commands under that heading.

 Double-click the command you want to send.

To send a command with arguments
e Click the command in the Command list.

You will be prompted for the argument in the box below the
Command list.
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e Enter the argument from the keyboard:

== Control Window - Meridian 861 - COM1 2
This window sends commands to the product attached ta the senial — pisconnect Ol
port of your computer, You can ko type commands on the MG —I* —I*
and MSR+ tabs. Part. [Comt

MSR+| MR Command |

et o typs n - 1D

~Walume: minus
Go to volume [1-39]
- 3o to volume number
“Yalume plus
Yelow button
- button
- AR Repeat

L Sublille select

[#- Function + M5R keys

Preset =
1 3
| v

e Click the Send button, or press (], to enter the command.

Control
Window
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Control
Window
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A F
Auto Build room correction 33 fetching settings from a product 8
filters, editing 41
B
Bass management page 20 H
Breadcrumb trail 5 help, on-line 6
C |
calibration, speaker 23 impulse response 37
cards, 800 series Information bar 5
adding 9 inputs, adding or removing 14
displaying properties 10 installation 4
removing 10
@ configuration L @
saving 30
) low-frequency response 38
starting 6
connections
drag and drop 13 M
making automatically 11 measurements
making manually 12 displaying 36
multichannel 14 multiple 39
Connection Wizard 11 repeating 38
controller Measurements tab 36
adding 7 MSR/MSR+ emulating 50
properties 8 multichannel connections 14
Control Window 49
crossover settings, subwoofers 21 0
Options dialogue box 24
D outputs, adding or removing 14
DSP presets 26
editing 26
preset mapping 27
user-defined 26
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P

printing connections 17

products, displaying properties 8

Products page 3,6

properties, displaying or changing 8

Q

quick tour 5

R

requirements 4

Room Correction 31
Auto Build 33
changing settings 44
filters 40, 41
profiles 31
troubleshooting 46

Room correction page 25

S

settings
fetching 8
storing 29

soft keys
changing layout 19
clearing 19
defining 18

Soft keys page 18

sources

adding 11

adding inputs or outputs 14

changing MSR+ key 12

printing connections 17

properties 8

renaming 12

reviewing connections 17

removing inputs or outputs 14
speakers

adding 15

calibrating 23

defining distances 22

printing connections

properties 17

reviewing connections 17
Speaker distances page 22
speaker layouts, defining 20
Store settings page 29
subwoofers

crossover settings 21

setting up 20

THX settings 21

T
THX settings 21

W

waterfall plot 37
Welcome page 5
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